From the Executive of VALL Carol Williams

Another successful VALL season draws to a close, and the 1992/93
Executive wish to thank members for their participation and support
during the year. We take this opportunity to welcome the 1993/94
Executive and hope they have as much fun as we have had. The new
officers are:

Gabriella Barsoum Membership Secretary
Gillian Crabtree Treasurer
Shirley Hyndman President
Karen Imeson Secretary

Elizabeth Kinersley Program Coordinator
Tracey Carmichael &
Jane Wells Newsletter

Thanks also to Pam Clancy and Eve Porter who worked with me on the
Nominations Committee.

The monthly program continues to play an important role in VALL.
Attendees at the May luncheon were interested to learn future directions
for UBC's School of Library, Archival and Information Studies and hope
for auseful partnership between the university and the library community.
In this climate of change and adaptation to fewer resources, the link
between academia and practitioners will become more important. There
are certainly no lack of ideas for future programs, so we can look forward
to another interesting year in 1993/94.

Thanks especially to my colleagues for the past two years. It has been a
learning experience for me, as well as an opportunity to meet the law
library community in Vancouver.

From the Editors Teresa Gleave & Joan Honeywell

Thisis our final issue of the VALL REVIEW. We wish to thank everyone
who has contributed articles and comments. We are especially grateful
to Nancy Cotter and the staff at Western Legal Publications for their
continued support. Best of luck to Tracey and Jane — we hope they have
as much fun as we did.




REVISED STATUTES OF BRITISH COLUMBIA: ELECTRONIC VERSION

Editors’ note:  Jane Taylor has kindly allowed us to publish this article with the understanding that the following description conforms
to their network and therefore not all the options on the FolioViews menu are discussed. The article was originally
prepared for staff at the Ministry of the Attorney General.

1. GETTING STARTED

Choose the Statutes icon on your Windows screen. Use the Tab key to go down to the section of the database you want to access,
(e.g. Eull Text), then press <Enter>. Use the Shift Tab to go up the list. You can also use the cursor keys to move up and down the list.
The Esc key will get you out of the database, in effect reversing the path you took to get to where you are.
2. CONTENTS

The electronic version of the Statutes includes all public statutes and amendments in force as of November 8, 1991, the Vancouver
Charter and all third reading bills enacted during the previous session of the Legislature. Please read the Explanation of In

for a complete explanation. Updates will roll forward in time, incorporating any previous third reading bills into the text of the statutes
and providing the text of any third reading bills from the most recent session of the Legislature.

3. SEARCH TIPS AND TRICKS

Sign on to the Fyll Text section of the database. (See the section called GETTING STARTED for an explanation of how to get
to Full Text.) The first page of the first statute will appear. Hit the space bar to bring up the search screen and type in a search term, such
as cabinet. You will see that you get 6 matches. You will also see the word cabinet highlighted in the list of words. Another way to search
isto cursor or page up and down the list of words and press Ctrl <Enter> to search that word. If you want to redo your search (too many
hits, for example), backspace over the word (or hit Ctrl Home) and type in a different one.

There are ways to combine search terms to produce quite a sophisticated search:

And A&B AandB

Or A/B AorB

Not AAB Abutnot B

Phrase "AB" A B as a phrase

Proximity "AB"@5 A within 5 words of B

Ordered proximity "A B"S A 5 or fewer words in front of B
Nesting (A&B/(C &D)AE (A& B)or(C &D)butnot E

It is also possible to use "wildcards" to truncate words, e.g. probat* for all words beginning in probat. The * can stand for any
number of characters. You can also substitute a ? for a single character, e.g. station?ry to retrieve stationery or stationary. You can use
as many question marks as you wish, each one representing a single character.

NOTE: Wildcards cannot be used in phrase or proximity searches.
Here is an example how to search for a specific section of an Act: "section 121 - municipal act” — the name of the Act must
be accurate, and the spacing and quote marks must be exactly as in the example.

To limit your search to a single Act, go into the Listing of Individual Acts. Either bring up the Act directly from the listing, or
do aquick word search to get to the right part of the listing (particularly useful if your Act is near the end of the alphabet). Then when you
run your search, you will know that the results apply only to that Act.

4. VIEWING THE SEARCH RESULTS

Once you feel you have put together an effective search, you can look at the results by pressing <Enter>. The number of "hits"
is noted in the top right hand comer. A "hit" is a section, also called a "Folio." The entire search result, i.e., all of the sections retrieved
by your search, is called a"View." It is important to remember this distinction when using the electronic Statutes. Use the Tab key to go
to the top of the next section, or page down through the sections, or press Ctrl G to go to a specific section. You can create a list of section
numbers by pressing Ctrl T. You can then cursor down the list, and press <Enter> to view a particular section. Pressing the Esc key will

Continued on page 3
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REVISED STATUTES OF BRITISH COLUMBIA: ELECTRONIC VERSION, cont'd.

take you back to the list. While in the list, pressing Ctrl T will take you back to the full text display. Ctrl Pgdn will take you to the last
hit and Ctrl Pgup will take you to the first.

S. PRINTING THE SEARCH RESULTS

While viewing your search results, you can print either a single section, the list of sections, the full text of a group of sections,
entire Act or a portion of text which you have blocked (instructions below). Here's where the distinction between Folio and View becomes
important.

Press Alt F to pull down the File Menu, then press P to print. You will be presented with three options. Make sure the cursor
is beside "Print" and press <Enter>. This will take you to a screen-full of options. Move between sets of options with the Tab key. DO
NOT press <Enter> until you reach the bottom of this screen. Use the cursor tochoose either Folio, View or Blocked Text. Tab through
the various sets of options. Now press <Enter>. When the "saving to disk, please wait” message disappears, your document will print.
If it does not, hit the Esc key once.

Before printing the full text of a group of sections, press Ctrl R. This will attach citation information to each section you print.
Otherwise you will end up with the text of a section and no clear reference to which Act it came from.

The following describes how to print an individual statute: from the Table of Contents, tab down to the Listing of Individual A
and press <Enter>. Cursor or page down to the Act you want and press <Enter>. Press Alt F, then P. Cursor down to View on the
Options Screen, tab through the option blocks, and press <Enters.

6. BLOCKING TEXT

You may wish to block an area of text. Think of it as extended highlighting. It can be a few words, a few lines or even a few pages.
You can print or create a file with the material that you have blocked. Place the cursor at the beginning of the material you want to block.
Press Alt E to pull down the Edit Menu. Press B for blocking. Use the cursor keys to extend the block as far as you wish. Then press
Alt F to pull down the File Menu, press P for print, and follow the directions for printing search results (above).

7. SIGNING OFF

Keep pressing the Esc key until you are back at the Windows screen.

8. HELP

There is a help facility which you can access by pressing the F1 key. There is also a small manual which comes with the system,

REPORT ON THE CALL CONFERENCE

As the recipient of the 1993 Peter Bark Memorial Fund Bursary, I would like to thank VALL for enabling me to attend my first
CALL Conference which was held in Halifax, Nova Scotia from May 16 — May 19, 1993. This was also my first visit to the Maritimes
and I enjoyed both the Conference and the City of Halifax.

The Conference was an excellent opportunity for me to meet face-to-face with colleagues from across Canada and even a few law
librarians from the United States and the United Kingdom.

The pre-conference workshop held on Sunday May 16, was "Personnel and Staffing in the Law Library" given by Elyse H. Fox.

Ms. Fox is the editor of L Information M Reports and I found the workshop and the time given to exchange ideas with other
participants very rewarding.

The opening night reception was held at Province House and I also attended an earlier reception for First Time and Foreign
Delegates in the library of this historic house.

Continued on page 4



REPORT ON THE CALL CONFERENCE, cont'd.

Among the sessions in the main program [ attended were those on the Criminal Justice System, Crown Copyright, and Evolving
Issuesin Health Care. I wasparticularly interested in hearing Lorne Rozovsky speak on ethical issues in health care and consent to treatment.

The special interest groups forums were very stimulating and I specifically found very helpful the joint forum presented by the
Private Law Libraries Special Interest Group and the Courthouse Libraries Special Interest Group on the topic "Challenge of the Nineties:
How to Survive." Another informative forum was held on computer assisted legal research.

Halifax is a very historic and charming city and the location of the Conference at the Sheraton Hotel in the waterfront district
allowed me to explore the city on foot. I got my daily exercise by walking up the hill to the Citadel and back. We were very lucky with
the weather and I was able to see Peggy's Cove without fog. Monday evening a reception was held in the new Dalhousie Law Library. The
last evening we were treated to a boat tour of the harbour and a lobster ceilidh which I most enjoyed and rushed out the next morning to
order lobster to bring home!

Again, I would like to take this opportunity to thank VALL and the donors to the Peter Bark Memorial Fund Bursary for giving
me the chance to attend the Conference.

Bronwen Jamison
Bull, Housser and Tupper

LETTERS

Thank you for meeting with some of our members and responding
to our concerns. We look forward to the paper supplements this

Editors’note:  See VALL REVIEW, March, 1993 for the | summer.
February 26th letter. Yours very truly,
. Johanne A.C. Blenkin
April 5, 1993 Vancouver Association of Law Libraries
- Carswell Thomson cc: Canadian Abridgment Advisory Board

Professional Publishing
One Corporate Plaza
2075 Kennedy Road
Scarborough, Ontario May 4,1993
MIT 3v4 Gary Rodrigues

. . Vice President - Publishing
Attention: Gary Rodrigues Carswell

. One Corporate Plaza
Dear Sirs: 2075 Kennedy Road
Re: i itation Scarborough, Ontario

MIT 3V4

Thank you for your response to the concemns outlined in our

February 26 letter. We have reviewed your proposal to produce
paper supplements for each volume, and believe it is the best
solution in the circumstances. Ideally, the set would be reissued.
However, fiscal reality dictates otherwise.

We do have one more suggestion. It would reduce confusion if you
could issue new labels for the consolidation eliminating the 1867-
1990 reference. This will look more professional than our hand-
made efforts and assist those users who do not read instructions or
notices.

Dear Mr. Rodrigues:
Re:; Canadi itations, 1867-

At a recent meeting of the Halifax Area Law Librarians (HALL),
ourorganization was provided with adetailed explanation by Cyndi
Murphy, Chair, Canadian Abridgement Editorial Advisory Board
of the steps being taken by Carswell to rectify errors and omissions

in the production of the Canadian Case Citations, 1867-1990.

Continued on page 5



LETTERS, cont'd.

Following Ms. Murphy's presentation, HALL resolved that aformal
response be made regarding Carswell's plans to issue corrective
supplements to Canadian Case Citations.

It is HALL's view that a preferred option would have been to
reprintthe productin its entirety at no cost to initial subscribers.
Given the costof this service, the reliance of academic law librarians
on the Canadian Case Citations as a teaching tool, and Carswell's
reputation among practising lawyers asa professional legal publisher,
the re-issuing of a revised and corrected product is viewed as the
appropriate option by HALL.

Many subscribers purchased this product primarily because of its
promised completeness and single stepresearch. Some law librarians
who bought Canadian Case Citations after errors and omissions
were identified by your editorial staff feel that Carswell has acted
in bad faith.

HALL believes that subscribers should have been directly canvassed
for their suggestions as to resolving the post-production problems
identified both by Carswell and by users. However, given that the
editorial decision has been made to issue a series of supplements,
HALL isprepared to acceptthis option after noting our dissatisfaction
with the shortcomings of Canadian Case Citations.
Finally, HALL strongly urges that in its future editorial plans,
Carswellallow more time forconsultation with itsEditorial Advisory
Board, and law librarian groups such as HALL, as to the design and
content of major legal products such as Canadian Case Citations.
Thank you for this opportunity to present the views of the Halifax
Area Law Librarians regarding the Canadian Case Citations, 1867-
1990.
Sincerely,
Merle Lister
Chair - HALL
cc: MALL, Ottawa/Hull Law Librarians Association, TALL,
Ontario Courthouse Libraries Group, Winnipeg Law Librarians
Group, Calgary Law Library Group, ELLA, VALL, Canadian
Abridgement Editorial Advisory Board

Editors’ note:  Jane Taylor forwarded this for VALL members’

interest.
April 20th, 1993

Minister of Attorney General
Parliamentary Building
Victoria, B.C.

V8V 1X4

~anada

Dear Sir/Madam

I am currently employed as a librarian by the Northem Territory

Government-Department of Law, Australia.

In 1994 I would like to arrange an exchange with a law librarian in
your department or one similar. My department is very keen on the
idea considering the similarities geographically and constitutionally.
The exchange would be for approximately six months, perhaps
from May until November.

The library collection is medium to large and has had excellent
support financially. The collection has international as well as
Australian material.

Enclosed is a copy of the history of the department and structure.
I will await your reply before sending any detailed information.

Yours sincerely,

Julie Fisher

Northern Territory of Australia
Department of Law

Solicitor for the Northern Territory
GPO Box 1722, Darwin, N.T. 0801

NOTICES

B.C. Court of Appeal Notice

Judgments in the eight aboriginal appeals will be handed down in
the Court of Appeal around the end of May or the beginning of June.
The judgments will be available in two volumes. Volume 1 will be

Delgamuukwetalv. Her Majesty the Queen. Volume 2 will contain
the seven remaining hunting and fishing appeals.

The Court of Appeal will be taking orders for these judgments in
May. Each volume will be available for $25. The set containing
Volumes 1 and 2 will be available for $50.

Disks of the judgments in WordPerfect 5.1 format will be available
for the same price.

If you are interested in ordering these judgments, please contact the
Court of Appeal at the special order number — 660-4995 and ask
for Ljuba Pavlovich.

Request for Reports from other Local Groups

VALL members who are active members of other local groups such
as GLABC or SLA and who would be interested in reporting on
their activities to the VALL membership, please contact Shirley
Hyndman, 682-3664.

INFOBITS

VALL - June10,1993. Round table discussion. Final meeting
for 1992/93.

Continued on page 6
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INFOBITS, cont'd.

» September, 1993. Watch your mail for the date of the
first meeting in the 1993/94 season.

August 3-6, 1993. Electronic Options for Extending
Information Access. Four days to choose from in these
Continuing Education seminars on overviews of the
industry, online database workshops, interlibrary loan
databases and an analysis of Internet. Location: School
of Library, Archival and Information Studies.
Information: Alice Bacon, Telephone: 922-3897.

usc -

BIBLIO NOTES

Recentitems ofinterestfromlibraryandlegalliterature, summarized
by Teresa Gleave.

- Computer-assisted legal research in the real world: a primer for

new attoneys and law clerks. In PLL Perspectives, April/May
1993, Vol. 4, Iss. 3, pp. 1, 4-6.

Thisis the text of a handout used by the author to train new
lawyers and law clerks. Rationales and scenarios where
computer searching may or may not be appropriate are
briefly covered. Some of the major differences between
LEXIS and WESTLAW arediscussed, as well as strategies
for minimizing costs in both systems.

Madonna, Sex and some B.C. libraries. By Lois Bewley. InBCLA
Reporter, February 1993, Vol. 37, No. 1, pp. 25-29.

The BCLA Intellectual Freedom Committee surveyed
elevenLower Mainland and two Vancouver Island libraries
for their collection policy on Madonna's controversial
book. Seven libraries purchased a total of seventeen
copies of which nine circulate and eight are considered
reference and non-circulating. Six librariesdid not purchase
the book, citing reasons such as price and format, lack of
reviews and/or interest, and failure to conform to the
library's collection policy. Newspaper articles and
editorials discussing the book and library and community
responses are excerpted, giving a taste of the controversy
generated by the book. This article provides a wonderful
snapshotof some of theconcens and problems encountered
by our colleagues serving the public library community.

PERSPECTIVES Teachin . Published
quarterly by West Publishing Company.
This journal was introduced by West last year and "is
intended to be a forum for all teachers of legal research and
writing". Itis notan advertising tool for the publisher and
does not contain any other advertisements. A perusal of
the first three issues yields many valuable articles for

h and writin

those of us who use online services as well as teach others
to use them. The spectrum is broad: plain language and
gender-fair communication; how to write book reviews;
educational theories such as analogization and cognitive
theory; and innovative marketing techniques. Mostof the
articles are somewhat scholarly and often have extensive
and valuable bibliographies. The publication is available
free of charge from:

Michelle McClaine
West Publishing Co.
Marketing - D5-06

610 Opperman Drive
Eagan, MN 55123-1308

The results of the PLL-SIS survey of technical services functions in
private law libraries, PartI. By CarolJ. Dawe. In PLL Perspectives
February/March 1993, Vol. 4, Iss. 2, pp. 10-14. Part II continued
in April/May 1993, Vol. 4, Iss. 3, pp. 10-15.

Theresults of this survey provide valuable and infrequently
collected information regarding technical operations in
law firm libraries. The survey covers details such as
number and qualification of staff and professionals; who
shelves books and how often the shelves are read; the
degree and kind of automated systems in use; filing
backlogs; the presence of clipping services; how libraries
interact with MIS departments; and much more. Using the
data collected, technical services standards are proposed
and will be elaborated upon in the future.

BOOKSTORE
Consolidated Regulations, Contact: Andrew Croll, Bartlett &
Company, Nanaimo, B.C. Telephone: 753-6616.

A selection of Law Reports and Federal Statutes: Contact: Ron
McGregor, Freeman & Company. Telephone: 683-4201.

British Columbia Law Reports, 1st series, vols. 1-72 and 2d series,
vols. 1-73. Contact: Lisa Taylor. Telephone: 660-2870.
Book Wanted

Volunteers and the Law (People's Law School Press)
Contact: Gabriella, Russell & Dumoulin Library.
Telephone: 631-4877.

MEMBERSHIP MATTERS

New Faces

Penny Bax, CCH Canadian Limited
Natasha Lyndon, McCarthy Tetrault
Tracey Carmichael, B.C. Courthouse Library Society



